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/\? /<1// Design the Next Header

A

\\ P When the forum started it was mentioned that we would have a quarterly contest for a header for the
X\’f websgite. We have not yet been able to do this. I thought it would be nice to have a monthly contest

9

a0 o0 a0 lao to design the header for each newsletter issue.
ﬂJgﬁmﬁﬁJgﬁﬁgﬁf Each month I will start a thread where you will post your creative designs. The post will includes the
\ @

dimengiong, theme for the month, deadline, etc. I will select a panel of 5 judges each month to pick the

NN

\ 7 {Lf"/f winner for the next issue. No one besides mygelf will know the actual until the newsgletter is posted on
J\//% the lst on the following month. The theme for the entire newsletter will be based on the winning
\/ <\/ header.

&\\ Our first contest will be for the May issue. Here are the requirements. Look for these on the forum as
S\ 2
well after thig igsue ig posted.

\0 1. Header must be 7.5 x 2.5 incheg at 300 ppi and save ag a .png file
$” ﬁfﬁf §($; < w}@ 5 2. Must contain Photoshop Creative Elements Community Newsletter and Volume and Issue Number
o \ @ - 3. The theme for May is Memorial Day or Mother’s Day.
\J\\/,_\/ 3%’/6 4. Post your header on Pixentral at 800 pixels on the widest side. Place a thumbnail link in the
\>// (// thread for the month’s challenge.
A\ ‘\/ 5. Also post the full sized header in your gallery with a link to it in your post.
/ \@\§ D 6. Deadline for May entries will be April 24th.

/‘{j (If the above guidelines for posting are not met your entry will not be considered)

$;§{§;§{$;§(\?J§q LET'S GET CREATING!!!!!!!!



Interview with Julie aka TNJewelg
By JenClark

1. Uil you tell us a little about yourself? Location/Career/Spouse/Children

| was born in Detroit. Michigan. At age 9 my family moved to Des Plaines. IL (a Northwest suburb of Chicago: where | ived for
36 years. In 2004 | moved to Lawrenceburg. TN a small rural community 3@ miles south of Nashville and 28 miles from the Ala-
bama border. When | ived in Des Plaines | worked for a sign company for 24 years. | did the accounts payable. receivable.
payroll biling and secretarial work. You’d think after working someplace for 24 years that you’d miss it but | don’t miss it in
the least! I’ve had some health issues since | moved to Tennessee and was diagnosed with Lupus last fall so it’s unlikely Il
ever be able to go back to work.

The only kids | have are the furry four legged kind. so most of my time is spent taking care of my husband Eddie and our
“z00”” which includes a Miniature Poodle named Abbey, two Yorkies named Gidget and ‘Cila (after Priscilla Presley) and two
outside dogs named Elvis and Molly. I’m working with someone from the Animal Welfare League right now to rescue a stray
that has lived up by our WalMart for a year. Some days | don’t think we’re ever going to capture her but she doesn’t know
how stubborn | am. I’ll keep trying till we catch her.

Eddie is my kindergarten sweetheart and we were married in 2006. We found each other after 33 years on Cassmates.com.
Eddie has two sons from a previous marriage. Jason is an Anesthetist and Shannon is an EMT/Fireman. Both boys were also
married in 2006 and we’re hoping for some grandkids soonl! (Edit: | just answered #7 when Jason showed up to tel us that
him &Melissa are expecting! I’'m going to be a Grandmal

2. What was the first thing that made you want to start using a camera? (Special photo. the equipment. or anything that sticks
out in your mind)

A friend of mine had a 35mm camera. The first time | picked up her camera and looked through the viewfinder at the inside of
a tulip. | was hooked. It didn’t take me long to go out and purchase my own camera. fly first 35mm was a Canon.

3. What made you decide to change from film to digital?
When | was working for the sign company my boss gave me a digital camera for one of my anniversaries there. | don’t think

I’ve picked up my 35mm more than 3 or 4 times since | came home with that first digital camera. Since then I’ve had 2 more
digital cameras before | finally got a DSLR.

H. How did you find your way to Adobe Photoshop Elements/CS?

My husband bought me Elements 50 for my birthday about 18 months ago. | played around with it a little bit but it wasn’t
until | found PET that | really wanted to learn more about Elements.

One day | was looking through the gallery at PET and saw a watercolor that Westiemom and Lisabee did and | was hooked. It
was because of those two that | joined PET. | was a bit intimidated by all the talent and spent most of my time lurking. |
haven’t been in PET in awhile but | think the last time | looked | had less than 70 posts there. It wasn’t until PCEC formed

that | started participating more.

5. What. if any, are your favorite plug-ins for elements/ CS?
Not too long ago | purchased Graffi’s big package of actions. I’m still playing with those a lot to see what they wil do. | also

lke Alien Skin’s plug-ins. What | really want is Mike Warren’s plug-ins that suzib introduced me to but until| upgrade to Pho-
toshop I’ll have to wait.

6. books are in your personal library dealing with photography and Photoshop? Do you favor one over the other? If so.
which one and why?
| have Photoshop Elements 5 Book for Digital Photographers. Surreal Digital Photography and fMlore Surreal by Barry Huggins
and Photoshop Finishing Touches by Dave Cross. | bought the last three at the same time and haven’t had a chance to
look through them much but I’m hoping that they’ll help me be more creative.
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What is your favorite person/place or thing to photograph’ Why?

My dogs. kids. flowers and Las Vegas! |love to photograph my dogs. though they don’t always cooperate! My niece’s little
girls are always so much fun to photograph. They don’t mind in the least when | pick up a camera and start taking their
pictures. Vegas has so many photo opportunities ... the lights. colors. the desert ... | always come home with hundreds of
photos when I’m in Vegas. Lately my focus has been on the antebellum homes here in middle south Tennessee.

What was the one thing in photography have you had a hard time learning?

The hardest thing for me has been to remind myself to backup and analyze the subject before | shoot. I’'m still at the very
bottom of photography: most of my photos that turn out are just pure luck.

What does your camera bag consist of? (st all lens. fitter. books. even gum wrappers!)

Nikon DH@x. 18-78mm and a new /8-280mm zoom lens. the charger for my battery and an extra battery already charged and
ready to go and | think there is some lens cleaning supplies in there. In the other camera bag is a Minolta Maxxum. S@mm.
135mm. 28mm, 78-218mm zoom lens and a big stack of Cokin filters and one of those little brushes that you can squeeze ar
and brush the dust off along with some lens cleaning supplies.

What is the next thing on your must have list?

I’d love to have a macro lens but | don’t see myself getting that for auhile since | just bought the 78-200 zoom lens.

What is your favorite photo and why’? Was this a planned capture or a chance shot? (Please include the photo)

| remember one night it was storming and | decided to set my camera up in the bedroom on a tripod with the shutter open.
When | picked up my pictures the next week the photos | had taken the night of the storm showed lightning barely missing
our car by inches. That was probably one of my most memorable photographs but my favorite would have to be one of my
first Yorkie named Tiger. She loved to pose for photos and | have some beautiful photographs of her.

How much time would you say you average on photography each week?

Between photography and Elements hours and hours. Elements is always open no matter what else I’'m doing on my com-
puter.

What are your hobbies/interest (including the obvious. photography) and in what order would you place them in from favorite
to least favorite?

My animals are tops on my list. I’d have to say photography would be next. genealogy, anything having to do with the fMo-
|ave Desert. American Indians and the Guil War.

2 of your photos were chosen for Columbia State Community College Intranet Board. Please tell us how they were chosen and
what this means to you’?

Our community college has a web site and they feature photographs taken of the middle Tennessee area. | submitted two
of my photographs. the iron gates at Rippavila Plantation named “freedom’s Open Door” and the photograph of one of
the “1860’s slave quarters on Rippavilla Plantation. A few days after | submitted them | received an emall that they were
going to be put in the rotation of the photographs appearing on the home page of their intranet. Unfortunately if you
aren’t a student you won’t be able to see them. | am honored that they want to display my two photographs. | never
thought I’d have one of my photographs chosen for anything let alone have the courage to submit one.

The two photos that Julie has mentioned above were both nominated last month for the Hall of Fame Image of the Month. They
are both outstanding photos and can be viewed on the following page and in Julie’s gallery HERE

Congratulations Julie on a well deserved honor.
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Click the Yorkie’s noge to download this calendar

Have you visited our sponsors site lately?

Visit and explore the outstanding images uploaded by people all over the
world. Check out the travel section and see photos from all over the world and dream of

being there. Plan your next photo book, whether it is 2 Baby book or keepsake of your
last vacation. Build a portfolio book to display your work to your clients. With the wide
variety of sizes from 3.75x2.5” up to 14x11”, square, portrait or landscape. What a better
gift for your Graduate than a Photo Book of their school years.
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Channels in Elements Part 1
By MichelB

You think that channels are somewhat mysterious and that Elements lacks the more advanced features of the great brother Photos-
hop ? As a matter of fact you’l discover that you already understand and master all of the necessary pieces of the puzzle and that
you can use channels in all versions of Elements to convert to black and white. to correct defective channels or work with individual
channels without altering the others. All you have to know to begin with is an idea of what RGB means. a very basic knouwlege about
layers and levels adjustments. To understand the principles and memorize the steps to assemble the puzzle we’ll use the analogy of how
color photography was made in the second part of the 19" century, As learning depends on practice I'll suggest a few practical exerci-
ses after which you should be able to work with channels independently at the end of this first part. (A second part wil deal more in
depth with the graycale components of channels).

Colors and our vision

White visible daylight is made of a continuous spectrum of hues varying from red to violet : the colours of the rainbow. The most important
thing to keep in mind is that it is possible o recreate in our visual system (eyes. bran) this infinity of hues by combining only 3 basic
hues : red. green and blue. Our retina has a category of cells (the cones), part of which are sensitive to red. others to green. others to
blue. The sensor of your digital camera has photosites sensitive to red. green and blue for every pixel Your LCD monitor display has also
LEDs emitting the same RGB colours for every pixel

RGB Combination

Digital recording of colours

A digital image representing light and colour is an array of figures specifying for each pixel the 3 values of red. green and blue. The info
palette (to be found by the menu /Window/info) is the tool to look at the values of a pixel They range from B to 255 (minimum to maximum
luminosity) for each colour R G and B. Black is @. 8. @ and white 255 , 255, 255 If all values are equal no color : it’s a shade of gray, For
the software to extract the red channel it must ignore the G and B values (setting them to 8 for each pixel). This is exactly what a true
red filter would do on your sensor or fim : block any of the green or blue components and let red pass through.

Elements tools to work on channels

We’ll examine two ways to work on individual RGB channels : the levels adjustment tool and blend modes. of which we’ll use only multiply
and its inverse. screen.

The levels adjustment tool is to be found under the menu /enhance/adjust lighting/levels. You already know how it can be used to ad-
just luminosity but for our purpose all we need to know is that you can Imit your adustments to a single basic colour (red for example).
What you have to do is to select the blue and green component and tell the software that for blue and green. you want the result to be
black (output value B instead of the default max. 255). You can either type the value @ or move the lower output slider completely left-
wards. Your image wil be in monochrome red. and necessarily dimmer than before. since you have blocked part of the incoming light. You
have extracted red. and discarded green and blue. You can save the result in a separate file (or a new layer) and do the same with blue
and green. This is the first step to work on individual channels. before learning how to recombine them later on.




Levels

® Learn more about: Levels

Channel: Green

Input Levels:

v Preview

Qutput Levels:
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Multiply and Screen.

The use of layers acting as coloured filters in multiply blend mode is less obvious but if you keep in mind that according to Adobe’s help
file . « /lultply looks at the color information in each channel and mulfples the base color by the blend color. The result color is always a
darker color. Mlultplying any color by black produces black. Multplying any color by white leaves the color unchanged » Let’s add a red
layer in multiply mode over your background image. In the red layer. the values of red are 255 (white), those of green and blue = @ (black).
Red is kept unchanged since the red value of 255 is lighter or equal to all values of the red channel of the background. on the contrary,
blue and green multiplied by @ are filtered. The result is exactly the same as the levels adjustment tool

Trnichrome separation/recombination

The principle of separation and recombination of the 3 channels in photography dates back to the middle of the 19" century, 3 different
photos were taken on monochrome plates through 3 coloured filters. and to recreate the colours, the (transparent) positive plates were
projected with the same coloured filters by 3 distinct projectors on the same screen. This is what we want to simulate in Elements. We
adlready know how to separate the components and we want Elements to recombine them. The solution is to stack the 3 components on
separate layers. We need a blend mode to mimic the addition of the 3 channels : in a movie projection room in the dark. the white screen is
dark and the 3 projectors combine the 3 coloured slides the screen. We’ll start in Elements with a black

background (acting as the unlit screen) on which we’ll add 3 coloured layers. The blending mode to lighten (shed light) over black is the
screen blend mode. the inverse of multiply. « Screen Looks at each channel’s color information and mulfplies the inverse of the blend
and base colors. The result color 1s alvays a lighter color. Screening with black leaves the color unchanged Screening with white produces
white. The effect is simiar fo projecting mulfple photographic shides on top of each other. » | cannot say better than Adobe.



Part 1 Summary : a layer setup with independant channels

-duplicate your background 3 times. naming the new layers red. blue and green (whichever order, no importance). and set the blend
mode to screen.

-activate you background and create a new layer above it. fil it with black

-For each of the upper layer. use the levels adjustment and choose the 2 opposite channels (for layer red. select green. then blue)
and for each replace the 255 output value by 6. as explained above.

You can checK visually that the recreated image is the same as the original You can already work on each individual channel : sharpen.
blur, denoise. dodge and burn. add linked adjustment layers, run filters.

Suggestion of exercises for training :

-recreate the RGB additive chart by drawing shapes of the 3 colours on different layers. set the blend mode to screen and add a
black layer under them. Move them so that they overlap.

-Play with the opacity slider of each layer. while having a look at the info palette
-Compare the result of separation via levels to that of multiply modes

-If you have add-ons for channels (Grafi. Grant. Hiddenelements. . .) compare with your own results.

Layers Y

Normal Opacity: 100%

S 2 Lock: |

red component screen

green component screen

Blue component screen

Background

Look for Part 2 in the next issue.



MOSAIC TILE PAINTING TECHNIQUE
By Linda Jamegon On PSE 4/Mac

This technique was born while trying to salvage some eagle in flight shots. The eagle snuck up behind
me; o instead of shooting out the open side window of my car (cars make a good portable blind) I only
got a couple quick shots through the not so clean rear window. The heavy glass of the window gave
enough of a soft focus effect that they just weren't tack sharp. The action and composition were good;
and since painting conversions often start out by diffusing the image, I thought of that as a good end
product.

Images that would be good candidates for this technique would have a subject against a relatively
plain background. Besides birds in flight, other images come that come to mind are hot air balloons,
boats at sea, flower close-ups, or could extract something and give it a plain background.

Select a processed image and duplicate it: file>duplicate. Add any extras you want (in one of my shots
I added a light beam brush by Obsidian Dawn). Flatten the image. I often make a duplicate of the back-
ground layer to make reverting easy if I don’t like what I'm doing so many steps down the road that
I've uged up the history memory by pressing Control/Command + J. Rename thig layer crosshatch by
double clicking on it and save the change by pressing enter. Go to fiter>brushstroke>crosshatch. Set
length to 9, sharp to 6, and strength to 1. Press ok.
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Duplicate the crosshatch layer. Rename thig layer mosaic tile. Go to filter>texture>mosaic. Set tile size

to 2,

r

grout width at 1, and lighten grout to 10. Click ok.
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With the mosaic layer active, either use the eraser tool to erase over the subject to allow the cross-
hatch to show through or select the subject and delete. If the brightness of the mosaic layer is too dif-
ferent from the subject, use enhance>lighting>brightness/contrast to adjust. My results are on the

next
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I look forward to seeing what everyone comes up with.



Montage Tutorial by Dame

1. File - New -> Blank File (The size of your ‘blank file” is determined by the size of your image that you will be using, If

you make the new file to large. then the whole image will end up going into one ‘square’. So size does matter)

x
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2. Create a new layer (see figure2)
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3. dick on the Rectangular Marquee Tool and create a rectangular area on the new layer (layer /.
H. Fill the rectangular area with White
5. Special Effect >Layer Styles > Drop Shadouws (see figure 3)
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Note the “star” on the right hand side of the layer (layer /). Double Click on this to go into the Layer Style->Style Settings
Change the follow:

Lighting Angle: @

Drop Shadow: checked

Size: 35
Distance: @
Opacity: 50 x

F Praview

Lightirg Angle: @ I o o

7 ¥ Drop Shadow

Sizer [ [ = [ |
Distance: () [o e
Opacity: @ |su_ %

[+ T Glow
[+ T~ Bevel
[+ T Stroke

‘J Learn more about: Layer Styles

Resat | Cancel | o4 I

| lke working backwards. This way | am able to keep my Style Settings without opening and making the changes on each layer. |
lke duping each layer and the use the Move Tool to move. turn. reduce the size. and make longer. etc. each rectangular area.

You can use more or less layers, but | find that S to /12 rectangular area layer make a nice montage template. The Key word here
is template. This way you can have different templates for your images. (Figure 5)
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If you rather start with the center and work out ... then remember to move the copy layer below the one you copy. (Figure 6)

6. With you neuly create template open. open the image you wish to create a montage from (see figure 7). Note that you

montage template |
/. Go to Select -> Al

s first and you image is second and highlighted.

8 Edit->Copy (Once copied. you can close the image file. only.) Now the fun begins.
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9. From the montage start doing the following;
a. Click on a layer
b. Press and hold. then click on a rectangular area. This will highlight the area (marching ants will appear). See figure 8 below
c. Go to Edit-Paste into Selection At this time. part of your image should appear within the selection (see figure 9).

Repeat a through c for each rectangular layer until all are completed.

8. Once dll of the layers are filled. click on the Move tool click on Auto Select Layer box. Now you can click on an area
and move it a little. turn it more if you like. etc. At this point you can click on any area and move. size, etc. to your Ik
ing. Once you are happy with it. click on the Auto Select Layer box to turn it off.

4l f you don’t ke the white background. just go to that layer (should be on the bottom) and fill it with the color that you
like.
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Eye Opening Tutorial
by Wags

Sometimes a picture is mostly perfect ex- Now create a new blank layer on the image
cept for a small thing ke closed eyes. or that needs the new eyes (or other part).
glare in a pets eyes. Here is a way to fix

those problems using the clone tool A//0pt click on ihengoediel R aE

document that has what you want and
then move to the document you are fixing
and place the clone stamp tool above the
“bad” eye in the picture.

Most importantly you need a photograph
where the problem doesn’t exist. This is a
picture of my dog Eljah. As you can see
on the left there is glare in his eye. The
picture on the right is picture taken of him

ot an earier date outside. Be sure that the blark layer is selected

and then carefully position the clone tool
and stamp once where you want the cor-
rect eye to appear. If you need to do an-
other eye be sure and label the first right
or left and then create a new blank layer
before repeating the steps with the other
eye.

Since the “new” eye is now on it’s own
layer you can rotate or manipulate it with
free transform (CTRL T) tool or nudge it
into position with the arrow keys.  Proper
placement and color match are the keys to
maKing this improvement un-noticeable.

Grab your clone stamp tool and make sure

it has “Use all Layers” checked in the op-

tions bar Here is an example using pictures of my
daughter:

% ’ ™ aligned I-I Use All Layers



Delicate Colored Pencil Sketch
By AngelicKim

This is a very simple and quick tutorial At Suzi’s request | am submitting it here for you all | hope you enjoy it.

| used a stock photo from stock.xchge

1. Open your image.

2. Gl J to duplicate the image

3. CirlU move saturation slider all the way to the left (-100)

4 Gl to invent

5. Cirl J to duplicate the layer.

6. Filter > Artistic > Colored Pencil > Pencil width /16 > Stroke Pressure 6 > Paper Brightness 50

7. Turn off the 2nd and 3rd layer eyes.

8. Reduce the opacity on the top layer to let the desired amount color show through from your original image.
Before

After
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http://www.sxc.hu/index.phtml

Blending Presets in Lightroom by SuziB & jlwilm

Auhile back | had asked Chuck if you could blend presets in LR. His answer to that was no. you had to make a virtual copy apply
a different preset to that one. Then export to CSg and blend there.

The other night being bored as usudal | started playing around in LR and found a way that you can blend presets in LR It is a
ittle convoluted but works great. Here are the steps | ?OOK to accomplish this.

1. open rau file (if you don’t want to mess with original raw. make a virtual copy)
2. add preset
3. export to edit in either elements or CS3 make sure stack with original and tiff is checked

* Adobe Photoshop Lightroom
Flo Edk Develop Photo Settings View Window Melp

ﬁ LIGHTROOM iy | Develop

AT

+ Edit Photo with Adobe Photoshop CS3

@ Edit a Copy with Lightroom Adjustments

[] stack with original Edit | cancel

@ 10:98pm

H. once you get it into CS3 or elements go back to LR
5. now here it gets weird (I have to do this but John didn’1) close LR don’t do anything to images just close it
6. open LR bacK up. you now should have a raw flle and a tiff file (see screenshot 2)

'&*' Adobe Photoshop Lightroom
File Edit Develop Photo Settings View ‘Window Help

COL Deep Negative

COL Deviant

COL Deviant2

COL Fried Eggs

COL Hamburg's Funky Twist
COL High Key

COL High Key 1

COL Indian Summer

£O1 13k Srila

Copy... Paste

2 photos




/7. select the raw fille. add a different preset.click on copy

8. select the tiff file (you should see loading on screen for a second or two)

9. click paste

0. Viola you now have two presets blended together. If you don’t like the look just click on undo. select the raw file and
start over. | have played around with adding 3 or more presets to the tiff file and it seems that it keeps blending

Now you are most lkely saying to yourself.”self why not just apply the second preset directly to the tiff. instead of the copy
and pasting”. | tried that ond%he results are not the same. But lFD)g all means try it that way also.

| had John test this and it works for him also but for some reason he does not have fo close and re-open LR. | have tried and
tried to do it without closing but can not get the tiff to show up for me. Have to close and open. If anyone can figure out why |
have to close and re-open. please tell me.

If you try this and find a better way, please let me know so | am update this

Dee-Dee sent me her workflow on blending and is completely different from this with completely different results. | am trying to
talk her into writing u her workflow for the newsletter also. ‘:|l<eeping fingers crossed
[ thank John so much because without his help | would not of been sure that it works.

If you want to mention this on another forums feel free to but please link back to this forum and the newsletter.

Raw with second preset

Raw original

....

Tiff with first preset Tiff with ble

ﬁd of>both presets And this is what you get if you
export both raw presets into
Elements or CS3 and blend there

T

——— e

This is just to show you the two different presets i
used and the final product. If you use this how to you will only have to files, the original and the blend. Or you could
have as many as you like

Go to page 27 (at the bottom) for one link to download all downloadable files in this issue.



Challenge of the Month

| have selected Suzi’s new challenge for the March Spotlight Challenge of the Month. We have many challenges for Elements and
Photoshop. Suzi has started one for AR and Lightroom.

ACR / Lightroom #1

Challenge #1is here. | am going to start this off with a bang. Am giving you three images to work with. All work must be done in
either ACR or LR except for cropping. sharpening and using your de-noise filter. | Know | prefer to so these in either elements or
C S 3

If you use a preset. please. name it and if you want a lnk to where you got it. Also if you want to tell your workflow.
lf you would lke to share a preset of your own would you please gve it to Km for the newsletter.

| hope to see a lot of forum members trying this. Remember this is for ACR and LR. Elements and Photoshop.

Click to visit the PCEC forum and this challenge to see what members have done.

A zip file with all 3 of the above RAW files can be downloaded from a link in the thread.



http://www.photoshopcreativeelements.com/viewtopic.php?f=31&t=2437

Pixels, PPl and Aspect Ration
By Codebreaker

One of the frequently asked question is ‘y camera produces an image of 3000 x 2008 pixels at 72PPl and I’'m told in need
300PP1?°

This raises the question of what is the relationship between Pixel Dimensions and PPI.

The most important thing to remember is that Digital Camera images have no physical size.  All you get in the image file is a bunch
of numbers that indicate the colour for each pixel In order to get a print from this image file the Pixels have to be ‘sprayed’
onto the paper. This is where the resolution or Pixels Per Inch (PPN figure comes into play,

Imagine first that you have an image that is 3000 x 2000 pixels. If your printer ‘sprayed’ one pixel every inch you’d see some-
thing ke the image below. where each pixel is one inch apart. t’s not going to be a very good print — large though 3000 x
2000”. (View it from a few hundred metres away and it may look oK)

® & & & 6 & 0 0 5 0 0 % % 0 0 0

Now make the pixels 8003 (approx. 300PP) inches apart and you’ll get something lke this.

A figure of 300PP! for resolution is the accepted ‘norm’ to give good prints. In other words the eye can’t see the pixels. In re-
ality your printer wouldn’t give you the dots of the first figure above since it wil try and fill the spaces with ink. What happens
though is that the image doesn’t appear very sharp because the printer has to ‘guess’ what goes in the gaps!

We’ve now established that your image is made up of Pixel Dimension and that when printing you need at least 308 Pixels to be
placed on every inch of your print. Well if you need 300PA and you have a piece of paper which is 6 x Hin, it’s not hard to see
that it’s going to need an image of 118008 x 1200 Pixels to fil it.

The magic formula then is that....
Physical Size = Pixel Dimensions / PPl

What this means then is that when printing you have to have enough Pixels to fit the paper size using a resolution of at least
300PP.  In reality you can get away with less but the quality of the print drops of. Having more just means bigger files and
longer to print.

Here’s a table that shows you some typical image sizes and the prints you could expect from them.

Camera MegaPixels Pata Size Print Size
Mbytes)

86
M4

H.3

7.2
229
12 343

O O Ul L] W




he data size is extremely large and it takes longer to print. but the print quality is no
ifferent from the green zone

he print quality is as finely detalled as the original alows and this is the recommended
one

he print quality is good but may lack a little detal but depends on the original and
lewing distance

The print quality is alright but may lack some fine detal Might be alright at longer

viewing distances

The print quality wil be less and begin to be noticeable.

Now back to the original question. Why was the assumption that the image from the Camera is at 72PPI?

If you’re familiar with EXIF data then you’ll know this contains lots of additional information about your image. What camera. when
you took the shot. colour space and so on.  One of the tags in the EXIF data is for resolution and while this is totally irrelevant
for Digital Cameras, other electronic documents do make use of this tag. It’s useful when scanning, for example.

Camera manufacturers are free to put whatever number they lke in the resolution tag field. Some Canons use 248, Kodaks 1180
and some don’t put anything there. If there is no value then the default is 72PPL

The kKey point is that for Digital Camera images this resolution field has no significance. You determine the resolution based on
the Pixel Dimensions and the size of the print you’re trying to make.

If you want to see what this figure is in your camera image then use the Elements Organiser Properties window.

=~ Properties >
General Tags History \I'n.‘re-tadata ]
=7 File Properties Y
Filename : CRW_2626_edited-1.psd .
Date Created : 304772006 18:02
Madified ¢ 30v7/2006 18:02
Image : applicatiunwnd.adobe.pr'
Width : 3072
Height : 2048
Color Mode : RGB
Rezolution » 240.00
File Size t 37775542
Color Profile : Adobe RGB (1558)
Bit Depth : 16
Document! s uuid:21CES2DCECIFDB1,
Creator : Adobe Photoshop Eleme
~ |IPTC
-

You can also open the image in the Editor and then go to Image » Resize > Inage Size then you’l see a diadlog box lke the one
below. This one shows an image of 3888 x 2592 Pixels which has a resolution of 380 PPP. which uill give a physical image size of
1296 % 864 inches. If | want | can change the resolution to any number | choose and the physical size wil change accordingly.
Look at the second screenshot below, where I’ve changed the resolution to 72PPl — a massive physical size —but a poor quality
print. But in both cases the pixel dimensions remain unchanged.



—

Image Size

Q Learn more about: Image Size

— Pixel Dimensions: 57.7M

Width: 33288 pixels

Height: 2592 pixels

— Document Size:

Width: | 12.96 inches
Height: | 2.64 inches
Resolution: | 300 pixelsfinch

|:| Resample Image:

Cancel

&

Help

Image Size

Q Learn more about: Image Size

— Pixel Dimensions: 57.7M

Width: 3388 pixels

Height: 2592 pixels

— Document Sizes

Width: | 54 inches
Height: | 35 inches
Resclution: |72 pixels/inch

[]Resample Image:

Cancel

Help

Re-sizing and re-sample is a topic that deserves it’s own article.



Scanning

| mentioned that the resolution field is used by other electronic documents. If you recall the magic formula from earlier, you’l
Know that if you have the Pixel Dimensions and a PPl value you can work out the Physical Size.  Therefore when you scan in a
document one thing you’ll have to decide on is a scanning resolution. Scanning is lke the reverse of printing. Instead of
‘sprayng’ a number of pixels on every inch of the paper. what the scan process does is ‘capture’ a number of pixels from
every inch of the document. And just lke printing if you can capture 300 pixels from every inch of your document you’ll be able
to print it out at the same size.

Imagine then that you have a & x 4 print on your scanner and you want to send it o someone so that they can print it out at 6
x4 You set the scan resolution to 300PPI and push the button. The image file then has the following information as well as
the colour data....

Pixel Dimensions = (6 x 308) X (H x 300) = 1800 x 1200

Resolution = 300PF!
With these parameters anyone can print the original document at the original size.
Which leads on to — what resolution do | need? And the answer is — it depends on what you want to do.
If all you want to do is make a print of the scan at the original size then scan at 360PFL

If you want to make a print that is tuice the size (tuice as wide and twice as high). then you need twice as many pixels. so scan
at BBOPFI. . ..and so on.

So. the more the enlargement you want. then the more pixels you need and the higher the resolution has to be.  Which is why
scanning 35mm Slides and Negatives to make prints needs the highest setting you scanner can achieve.

Aspect Ratios
This at least doesn’t have to do with the relationship between Pixels and PPl so you can breathe a little easier.
Another frequently asked question is why images don’t always fit onto the paper.

The reason behind this is in the term Aspect Ratio. which is the relationship between the width and height of your image. The
camera sensor is a physical shape — rectangular — and the pixels are distributed across it. This means that there wil be more
pixels in one direction (width) than the other (height).

»
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If you look in your camera manual it should tell you the aspect ratio of your sensor. Typical values are:-
32 43 and 163

Unfortunately paper sizes don’t always line up with these aspect ratios. Some common paper sizes are:-
6'x4H (3:2. 7'x5(@28:2) 10" x8(25:2). AH(2828:2)

Which means a 32 image uill fit correctly onto a 6 x H paper but not any of these others. A 4.3 image will not fit correctly on any
of them nor wil the “16:9.

What happens is this if you’re using a 6 x 4 paper. The black represents the format of the image and the red the represents
the format of the paper. Either it fit’s exactly or you get white space at the sides. or some of the image gets cropped off.



J.2 Image 4.3 Image

" x 4" FPaper " ¥ 4" FPaper

16:9 Image

b" x 4" FPaper

There is no way that the whole image can be made to fit exactly onto every different paper size. You either have to accept
that the white borders may be un- even or that some of your image may get lost.

Within Elements you can crop your images into the same format as the paper but this still results in some of your image being
lost. You can of course stretch or shrink your image but this will result in distortion.

Summary

e Digital Camera images do not have a physical size
® The resolution figure that you see for your camera image has no meaning
® You decide the resolution when you go to print —it’s based on the Pixel Dimensions and the paper size

® The optimum resolution is 308FA
If you don’t have enough pixels in the image to get the print size you need at the optimum resolution. you need to
re-sample your image.

® Scanned images often include the resolution which allows you to re-create the original document at the original size.

The more enlargement you need when going from a scan to a print. will need a higher scan resolution.

® |nage aspect ratios — the ratio of width to height — often differ from the aspect ratios of papers.

Images may need to be cropped or prints may have un-even white space




Natural Boy Mini Kit by Wags

Click to download one zipped file containing all downloadable files for
the newsletter. Files in this zipped folder are also zipped.


http://www.4shared.com/file/42587023/147a4c55/_2__Issue5downloads.html?dirPwdVerified=9f1c22c9

Calendar Template
By JenClark

Directions on creating a circle to mark the day/year:

> Create a new layer (place this on top)

>Select the elliptical marquee tool then draw a
selection around the date.

> Edit

> Stroke (in the selection box | chose 10px, picked a
color, outside)

> Then select Ok

Do this for each circle you make. Here is the example of
what my final design looks like.
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If you have your circles on different layers and save your
design as a psd, you will be able to change the date and photo
in a snap. Journaling is not included on this png so feel free
to add your own. Hope you enjoy this layout.

All files contained within this zip file is © 2008 by Jenifer
Clark aka IBJC.

Credit for using any file within this zip file should be given
to:

IBJC. PERSONAL USE ONLY. NO COMMERCIAL
USE IS ALLOWED.

Allit takes is a little bit of
Iwe ol SRt o nce Go back one page to download all
and Sadieis a Aappry dog fileg available in thig iggue

nireriClarlc




Old Time Mini Kit by Ladybug

To
Download
Judy's
Mini Kit,

Go back to page 27
And download all files

For thig iggue in one

Convenient file.
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Hall of Fame
Image of the Month
March 2008

Congratulations
To all the nominees and thank you to everyone who voted.

This monthg Hall of Fame Image of the Month i< a tie.

Congratulations to AussieDen for West Cap Wave
And SuziB for I-Think-I-Got-It

Third place also goes to AussieDen for Old Trawler
-




